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The information provided in this documentation contains general descriptions and/or 
technical characteristics of the performance of the products contained herein. This 
documentation is not intended as a substitute for and is not to be used for 
determining suitability or reliability of these products for specific user applications. It 
is the duty of any such user or integrator to perform the appropriate and complete 
risk analysis, evaluation and testing of the products with respect to the relevant 
specific application or use thereof. Neither Schneider Electric nor any of its affiliates 
or subsidiaries shall be responsible or liable for misuse of the information that is 
contained herein. If you have any suggestions for improvements or amendments or 
have found errors in this publication, please notify us. 

No part of this document may be reproduced in any form or by any means, electronic 
or mechanical, including photocopying, without express written permission of 
Schneider Electric.

All pertinent state, regional, and local safety regulations must be observed when 
installing and using this product. For reasons of safety and to help ensure 
compliance with documented system data, only the manufacturer should perform 
repairs to components.

When devices are used for applications with technical safety requirements, the 
relevant instructions must be followed. 

Failure to use Schneider Electric software or approved software with our hardware 
products may result in injury, harm, or improper operating results.

Failure to observe this information can result in injury or equipment damage.

© 2012 Schneider Electric. All rights reserved.
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Safety Information
Important Information

NOTICE

Read these instructions carefully, and look at the equipment to become familiar with 
the device before trying to install, operate, or maintain it. The following special 
messages may appear throughout this documentation or on the equipment to warn 
of potential hazards or to call attention to information that clarifies or simplifies a 
procedure.
33003805 07/2012 5



PLEASE NOTE

Electrical equipment should be installed, operated, serviced, and maintained only by 
qualified personnel. No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction 
and operation of electrical equipment and its installation, and has received safety 
training to recognize and avoid the hazards involved.
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About the Book
At a Glance

Document Scope

This document describes the Unity Loader stand-alone tool.

The Unity Loader transfers Unity Pro applications bidirectionally between a PC and 
a Modicon M340, Premium or Quantum PLC. It also transfers firmware (FW) mono-
directionally from a PC to a Modicon M340 PLC.

Validity Note

This documentation is valid for the Unity Loader.

User Comments

We welcome your comments about this document. You can reach us by e-mail at 
techcomm@schneider-electric.com.
33003805 07/2012 7
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Unity Loader

General Information

33003805 07/2012
Unity Loader General Information
Overview

This chapter comprises general information about the Unity Loader and the 
dedicated hardware platforms M340, Premium and Quantum.

What Is in This Chapter?

This chapter contains the following topics:

Topic Page

General 10

Installation 11

Preconditions 12
9



General Information
General

Overview

The Unity Loader is a stand-alone software tool dedicated to the M340, Premium 
and Quantum hardware platforms. A Unity Pro license is not required to use the 
loader.

The Unity Loader software provides the following transfer features:
transfer of a Unity Pro application from a PC to a Modicon M340, Premium or 
Quantum PLC.
transfer of a Unity Pro application from a Modicon M340, Premium or Quantum 
PLC to a PC.
transfer of firmware (FW) from a PC to a Modicon M340 PLC or to a module with 
firmware of the Modicon M340 platform.

Note: The Unity Loader software requires one of the following operating 
systems:

Microsoft Windows XP Professional
Microsoft Windows Vista Business
Microsoft Windows 7 Professional
10 33003805 07/2012



General Information
Installation

Overview

Insert the CD Unity Loader in the CD-ROM drive.

Autorun launches the setup automatically. If not, double-click Setup.exe.

The Unity Loader Installation Wizard will guide you through the installation.
33003805 07/2012 11



General Information
Preconditions

Before FW Transfer

NOTE: Save the PLC program and other data before transferring firmware (FW) 
from a PC to a PLC or to a module with firmware.

PLC in Stop Mode

Stop the PLC before you start firmware (FW) transfer.

If you do not stop the PLC before trying to transfer firmware (FW), you will be 
informed by the Unity Loader that the PLC must be stopped.

After confirming this message, the Unity Loader will stop the PLC automatically.

NOTE: A firmware (FW) transfer is only possible on a M340 hardware platform.

WARNING
RISK OF UNINTENDED EQUIPMENT OPERATION

Before transferring data to a PLC or to a module with firmware make sure that you 
have selected the correct project and firmware files and entered the correct target 
address. Verify the address by comparing the MAC address printed on the device 
with the MAC address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
12 33003805 07/2012
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Communication
Target Devices

Overview

The Unity Loader target devices are as follows:

processors (CPUs) of the Modicon M340 platform
Ethernet modules of the Modicon M340 platform
other modules (with firmware) of the Modicon M340 platform
processors (CPUs) of the Modicon Premium platform
processors (CPUs) of the Modicon Quantum platform

Run/Stop Command

The Unity Loader can send a run or stop command to the processor.

WARNING
RISK OF UNINTENDED EQUIPMENT OPERATION

Before starting/stopping a PLC make sure that you are connected to the correct 
target address. Verify the address by comparing the MAC address printed on the 
device with the MAC address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
13



Communication
Communication

M340 CPUs are accessible through their USB or Ethernet ports
M340 Ethernet modules are accessible through their own Ethernet port 
(crossover cable, point to point)
Other modules (with firmware) of the Modicon M340 platform are accessible 
through the CPU (connection on a CPU port).
These modules can not be accessed through Ethernet modules.
Premium CPUs are accessible through their Unitelway (UNTLW) ports.
Quantum CPUs are accessible through their Modbus ports.

WARNING
UNKNOWN OPERATIONAL STATE OF EQUIPMENT

Evaluate operational state of equipment before starting or stopping a PLC. 
Unintended situations can occur if system state is not confirmed prior to starting or 
stopping a PLC.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
14 33003805 07/2012
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Unity Loader Dialog Box
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Unity Loader Dialog Box
Overview

This chapter comprises information about the tabs of the Unity Loader dialog box.

What Is in This Chapter?

This chapter contains the following topics:

Topic Page

General Description of the Dialog Box 16

Project Tab 22

Firmware Tab 29

Save on Memory Card 34

Options Tab 38

About Tab 40

Scan Network Dialog Box 42

Transferring Data Dialog Box 44
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Unity Loader Dialog Box
General Description of the Dialog Box

Overview

The user interface of the Unity Loader is a dialog box with 4 different tabs:
Project tab
transfer of a Unity Pro application (program, data, user files) from a PC to a PLC 
or vice versa
Firmware tab
transfer of firmware (FW) from a PC to a PLC or to a module with firmware
Options tab
general settings for the Unity Loader
About tab
information about your Unity Loader (version, copyright, etc.)

Transfer FW or Transfer Project

Start PLC / Stop PLC

WARNING
RISK OF UNINTENDED EQUIPMENT OPERATION

Before transferring data to a PLC or to a module with firmware make sure that you 
have selected the correct project and firmware files and entered the correct target 
address. Verify the address by comparing the MAC address printed on the device 
with the MAC address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

WARNING
RISK OF UNINTENDED EQUIPMENT OPERATION

Before starting/stopping a PLC make sure that you are connected to the correct 
target address. Verify the address by comparing the MAC address printed on the 
device with the MAC address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
16 33003805 07/2012



Unity Loader Dialog Box
Launching the Unity Loader

Launch the Unity Loader via Start → All Programs → Schneider Electric → 
SoCollaborative → Unity Loader.

General Structure

The following areas are included in each of the 4 tabs:
tab selection (at the top of the dialog box)
tab specific area
Connection
Memory Card

NOTE: If Unity Loader is connected to a CRA module the caption Memory Card is 
changed to Internal Memory.

command buttons (at the bottom of the dialog box)

WARNING
UNKNOWN OPERATIONAL STATE OF EQUIPMENT

Evaluate operational state of equipment before starting or stopping a PLC. 
Unintended situations can occur if system state is not confirmed prior to starting or 
stopping a PLC.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
33003805 07/2012 17



Unity Loader Dialog Box
After launching the Unity Loader 2.2, the dialog box will open with the Project tab.

Tab Selection

To select a tab click the respective tab selector (Project, Firmware, Options, 
About).

Tab Specific Area

The content of the tab specific area depends on the individual tab. For more 
information see the respective tab description

Project tab (refer to the Project Tab (see page 22))
Firmware tab (refer to the Firmware Tab (see page 29))
Options tab (refer to the Options Tab (see page 38))
About tab (refer to the About Tab (see page 38))
18 33003805 07/2012



Unity Loader Dialog Box
Connection

NOTE: If Unity Loader is connected to an Ethernet Remote I/O header 
(BMX CRA 312 •• or 140 CRA 312 ••), a few information is different compared to 
standard CPU. It is not possible to start or stop this module as it does not contain an 
application. For this reason it is not possible to download or upload applications or 
application-related data.

The connection area comprises the following elements:

NOTE: Devices are addressed by TCP/IP addresses, Modbus addresses, 
Unitelway addresses or through point-to-point connection via USB (default). The 
address can either specify a CPU or an Ethernet module.

Memory Card

The memory card area comprises the following elements:

Element Description

Media This list box displays one of the 4 possible connections:
Ethernet
USB (default)
UNTLW
Modbus

To select a connection, click the arrow and select the respective 
connection in the list.

Address: This list box displays the address of the target device e.g. SYS (USB or 
UNTLW), 139.158.105.141 (Ethernet) or 31 (Modbus).
To select another address click the arrow and select the respective 
address in the list or type the address you want to connect to.

PLC: This box indicates the state of the PLC:
RUN
STOP
HALT
LOADING
NOCONF
ERROR

Element Description

State: This box indicates the state of the memory card installed in the connected 
module:

OK
Absent
Read only
Access error

Free Space: This box indicates the free space available on the memory card file system 
partition of the connected PLC.
33003805 07/2012 19



Unity Loader Dialog Box
The following data are stored in the file system partition of the memory card on the 
M340 hardware platform:

User Web Files (CPUs with Ethernet and NOEs)
the Factory Cast default Web site
potentially custom web pages
some user files relative to the Web site

Data Storage (CPUs only)
user files managed by the application with the file management function blocks 
or
files transferred by the user with FTP

Firmware (FW)
files transferred by the Unity Loader for FW upgrade

NOTE: If no memory card is installed in the M340 PLC, the firmware (FW) can not 
be transferred to the M340 PLC, because the FW is temporarily stored on the 
memory card.

NOTE: The Free Space shown for Memory Card is relative to the whole file system 
partition. Please refer to the memory card characteristics to see what is the size that 
can be allocated to the user files. FW update will not be possible in case of 
insufficient free space.

Note: The memory card at the Premium hardware platform is structured in the 
following way:

Program and symbols
Constants
Additional data storage
20 33003805 07/2012



Unity Loader Dialog Box
Command Buttons

The text of some buttons changes depending on the actual situation (e.g. 
Connect/Disconnect). Grayed buttons are disabled.

The command button area comprises the following buttons:

Help Button

NOTE: There is no Help button available in the dialog box. To launch online help 

press F1 or click the  button in the title bar.

Button Description

Scan... Click this button to open the Scan Network dialog box. Network scanning is 
used to detect IP addresses available in the network. For more information 
refer to Scan Network Dialod Box (see page 42).

Connect / 
Disconnect

Click this button to connect/disconnect the Unity Loader to/from the selected 
PLC.

PC<=>PLC Click this button to select the data transfer from PC to PLC or from PLC to PC, 
depending on the selected transfer direction. The current transfer direction is 
indicated by transfer signs (arrows) in the tab specific area of the Project tab 
and the Firmware tab. The transfer direction can only be selected for all 3 
transfer signs (arrows) at the same time.
Note: It is not possible to transfer the FW from PLC to PC. For the Firmware 
tab the PC<=>PLC button is disabled.

Transfer Click this button to start the transfer between the PC and the PLC. The transfer 
direction depends on the previous executed selection. The Transferring data 
dialog box opens (refer to the Transferring Data Dialog (see page 44)).

Start PLC / 
Stop PLC

Click this button to start/stop the PLC (see page 16).
NOTE: If Unity Loader is connected to a CRA module the button Start PLC / 
Stop PLC is disabled.

Close Click this button to close the Unity Loader dialog box.
The Close button is disabled during transfer.
33003805 07/2012 21



Unity Loader Dialog Box
Project Tab

Overview

This tab comprises the following services:
project transfer

transfer of a Unity Pro application from a PC file (*.STU, *.STA, *.STM) to a 
PLC
transfer of a Unity Pro application from a PLC to a PC file (*.STA, *.STM)

project data transfer
save application data values from a PLC to a PC file (*.DAT)
restore application data values from a PC file (*.DAT) to a PLC

project files transfer
save user files (data storage files and/or user files in the embedded Web site) 
from a PLC to a PC file (*.CAR)
restore user files from a PC file (*.CAR) to a PLC

Main Parts

The specific area of the project tab consists of 2 main parts:

PC Project properties on the left specify the content of the files stored on the PC.
PLC Project properties on the right specify the current status of the files stored 
on the connected PLC.

The transfer signs (arrows) between the 2 property areas indicate the transfer 
direction and significant comparison results between PC project and PLC project.
22 33003805 07/2012



Unity Loader Dialog Box
Representation

After launching the Unity Loader 2.2, the dialog box will open with the Project tab.

NOTE: 

If Unity Loader is connected to a CRA module it is not possible to upload or 
download:

PC Project
PC Project Data
PC Project Files

Therefore the checkboxes are disabled and direction arrows are crossed.
33003805 07/2012 23



Unity Loader Dialog Box
PC Project Properties

The PC Project section consists of the following elements:

Element Description

PC Project The list box at the top displays the current project file with its path.
To select a prior transferred project file click the arrow and select the 
respective project file.

To select any other project file click the ... button ( ). This opens the dialog 
box Select application file where you can select the desired Unity Pro 
project file.
Further project file information:

Name: name of the Unity Pro project (default is STATION)
Last Build: date and time of the last Unity Pro project build
Version: version of the Unity Pro project

PC Project 
Data

The list box at the top displays the current project data file with its path.
To select a prior transferred project data file click the arrow and select the 
respective project data file.

To select any other project data file click the ... button ( ). This opens the 
dialog box Select a data file where you can select the desired Unity Pro 
project data file.
Further project data file information:

Name: name of the Unity Pro project data file
Last Build: date and time of the last Unity Pro project build
%M: located variables (bits)
%MW: located variables (words)
Unlocated Data: data of function blocks and application

PC Project 
Files

The list box at the top displays the current project files archive with its path.
To select a prior transferred project files archive click the arrow and select 
the respective project files archive.

To select any other project files archive click the ... button ( ). This opens 
the dialog box Select a storage file where you can select the desired 
Unity Pro project files archive.
Note: The project files archive (*.CAR) is a backup file only and can not be 
edited with other tools.
The following files are stored as parts of the *.CAR file, if existent on the PLC.

User Web Files: user web files stored on the memory card of the M340 
PLC
Data Storage: user files stored on the memory card of the M340 PLC via 
special function blocks
24 33003805 07/2012



Unity Loader Dialog Box
PLC Project Properties

The PLC Project section consists of the following elements:

Enable Transfer (Check Boxes)

The specific area of the project tab provides the possibility to transfer 3 different 
parts of a Unity Pro project:

project (*.stu, *.sta, *.stm)
project data (*.dat)
project files (*.car)

By default all parts are selected, which allows a transfer of a project in one operation.

Each part of a project can be excluded from transfer by clearing the respective 
Enable Transfer check box. A deselected part is grayed and its transfer sign (arrow) 
is red and crossed out.

Even for excluded parts the available information is displayed to provide the context 
information.

NOTE: For the following reasons, the check boxes are disabled and the color of the 
arrows is switched to red:

invalid files (e.g. files not created with Unity, but with valid extension)
PLC in NOCONF state (not configured)
file not supported by the hardware platform (*.car is not supported by the 
Premium CPU)

Element Description

PLC Project Enable Transfer see below.
Project file information:

Name: name of the Unity Pro project (default is STATION)
Last Build: date and time of the last Unity Pro project build
Version: version of the Unity Pro project

PLC Project 
Data

Enable Transfer see below.
Project data file information:

Name: name of the Unity Pro project data file
Last Build: date and time of the last Unity Pro project build
%M: located variables (bits)
%MW: located variables (words)
Unlocated Data: data of function blocks and application

PLC Project 
Files

Enable Transfer see below.
The following files are stored as parts of the *.CAR file, if existent on the PLC.

User Web Files: user web files stored on the memory card of the M340 
PLC
Data Storage: user files stored on the memory card of the M340 PLC via 
special function blocks
33003805 07/2012 25



Unity Loader Dialog Box
Transfer Signs (Arrows)

Transfer signs (arrows between the PC´s and PLC´s property areas) indicate:

the transfer direction
significant comparison results between the PC and the PLC projects

The transfer direction can be changed by clicking the PC<=>PLC button. The 
transfer direction can only be changed for all 3 signs (arrows) at the same time.

Comparison Results

Comparison is only done for transfer from PC to PLC.

The comparison results are represented by different colors of the arrows:

Green indicates that these parts of the PC and the PLC projects are compatible.
Yellow indicates that these parts are partially compatible but a faultless transfer 
can not be assured.
Red indicates that these parts are not compatible. In this case the transfer sign is 
additionally crossed out.

NOTE: If the Unlocated Data part is not compatible with the project embedded 
inside the PLC, only the located variables (%M, %MW) are transferred. A warning 
message is displayed and the arrow color switches to yellow.

Transfer from PLC to PC

NOTE: For transferring a project from PLC to PC no comparison is done and 
therefore color indication is not available. If you try to transfer a file that already 
exists, you have to confirm to overwrite it.

If you transfer a project from PLC to PC the appropriate boxes at PC side (PC 
Project, PC Project Data, PC Project Files) are filled automatically by the 
Unity Loader.

If a history exists for the selected project, the boxes are filled with historic input.
For new projects the names are generated from the Default backup directory 
(to be set on the Options tab) and the project name on PLC.
If, for example, the project name on PLC is Motor_01 and the default backup 
directory is C:\Applications, the following names will be generated:

PC Project: C:\Applications\Motor01.sta
PC Project Data: C:\Applications\Motor01.dat
PC Project Files: C:\Applications\Motor01.car
26 33003805 07/2012



Unity Loader Dialog Box
Entering File Names

The dialog box supports you in entering file names:

If you already specified names, the respective boxes are automatically filled with 
historic input.
If you enter new names in one of the list boxes, a proposed entry is automatically 
entered in the next list box. Example: If you enter C:\Applications\Motor_01.stu in 
the PC Project box and you click the empty PC Project Data box afterwards, it 
will automatically be filled with C:\Applications\Motor_01.dat. You can confirm 
this proposal or overwrite it.

File Format

To transfer a project from PC to PLC you can select a file in one of the three formats.

The Unity Loader will save a project, transferred from PLC to PC in *.STA or *.STM 
format, depending on the project settings in Unity Pro (Upload Information Include/ 
Without Upload Information). See table below.

Upload Information Included

File 
Format

Description Comment

*.STU Unity Pro project file project including source code and Unity Pro 
workspace data

*.STA Unity Pro archive file project including source code but without Unity Pro 
workspace data
This archive file is very compressed.

*.STM Unity Loader specific 
project file

binary project data only, required for execution on PLC
It contains no source code and can therefore not be 
read by Unity Pro. 
Note: This file format can be used to backup the PLC 
project data.

Unity Pro  Unity Loader  PLC

Via Tools → Project Settings → 
General → PLC embedded data 
the checkbox Upload 
Information is selected.
A project is saved/archived in 
*.STU or *.STA format

-> Such a binary project can be 
transferred to PLC with the 
Unity Loader.

-> The binary project runs on the 
PLC.

Such a file in *.STA format can be 
opened with Unity Pro (but 
without the former workspace 
data.)

<- Such a binary project can be 
transferred from PLC to PC with 
the Unity Loader and is saved in 
*.STA format.

<- The binary project runs on the 
PLC.
33003805 07/2012 27



Unity Loader Dialog Box
Without Upload Information

NOTE: To save space on the PLC, it is recommended not to select the checkbox 
Upload Information.

For detailed information about *.STA format and Upload Information please refer to 
the Unity Pro Operating Modes Manual.

File Format After Online Modification

Online modifications of a project via Unity Pro can result in *.STM file format.

In Unity Pro you built a project with the checkbox Upload Information selected.
With the Unity Loader you transferred such a binary project to PLC.
With Unity Pro you online modified the program in the PLC.
(The upload information is no longer up-to-date).

NOTE: Either Unity Pro or the Unity Loader can be connected to a PLC at the same 
time.

Now you try to disconnect the PLC from Unity Pro and a dialog box informs you, 
that the upload information is not up-to-date.
If you confirm to update the upload information (with Yes) it is updated.
If you negate to update the upload information (with No) it is not updated.
Trying to transfer such a not updated project from PLC to PC with the 
Unity Loader, you will be informed that the upload information is not up-to-date 
and the project will be stored in *.STM format.

Unity Pro  Unity Loader  PLC

Via Tools → Project Settings → 
General → PLC embedded data 
the checkbox Upload 
Information is not selected.
A project is saved/archived in 
*.STU or *.STA format

-> Such a binary project can be 
transferred to PLC with the 
Unity Loader.

-> The binary project runs on the 
PLC.

Such a file in *.STM format can 
not be opened with Unity Pro.

<- Such a binary project can be 
transferred from PLC to PC with 
the Unity Loader and is saved in 
*.STM format.

<- The binary project runs on the 
PLC.

- - A file in *.STM format can be 
transferred from PC to PLC with 
the Unity Loader.

-> The binary project runs on the 
PLC.
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Unity Loader Dialog Box
Firmware Tab

Overview

This tab comprises the following services:
immediate firmware (FW) upgrade (or downgrade) of the target device (CPU, 
NOE or other modules with firmware)
generating a memory card to be used later for firmware upgrade of another PLC

NOTE: A firmware (FW) transfer is only possible on an M340 hardware platform.

Main Parts

The specific area of the Firmware tab consists of 2 main parts:

PC firmware properties on the left specify the content of the files stored on the 
PC.
PLC firmware properties on the right specify the content of the files stored on the 
PLC.

The transfer sign (arrow) between the 2 property areas indicates the transfer 
direction and significant comparison results between PC and PLC firmware (FW).

NOTE: It is not possible to transfer FW from PLC to PC.

Precondition

If no memory card is installed in the M340 PLC, the firmware (FW) can not be 
transferred to the M340 PLC, because the FW is temporarily stored on the memory 
card.
33003805 07/2012 29



Unity Loader Dialog Box
Representation

Firmware tab

PC FW Properties

The PC firmware (FW) properties area consists of the following elements:

Element Description

PC The list box at the top displays the selected FW file with its path.
To select a prior transferred FW file click the arrow and select the 
respective FW file.

To select any other FW file click the ... button ( ). This opens the dialog 
box Select a Firmware File where you can select the desired FW file.
Further information:

Device: name of the device
Version: version of the FW
Description: description of the FW
30 33003805 07/2012



Unity Loader Dialog Box
PLC FW Properties

The PLC firmware (FW) properties area consists of the following elements:

Firmware (FW) Information

There may be more than 1 FW to be displayed and compared for 1 device. This 
information is displayed in additional rows.

By default, main information (device name and version) is displayed. Use the 
horizontal scroll bar to display the entire information.

Position the mouse pointer on a listed FW to display the related information (tool tip).

Firmware (FW) File

The FW file (*.ldx) is a zip file that contains:

a script for the Unity Loader defining the information and the way it will be 
transferred
several FW parts for each device, which have to be kept consistent

So you have to select only 1 file to guarantee consistency.

MAC Address

The MAC address is displayed for Ethernet devices.

This helps you to identify the device more securely.

The MAC address is not available for intelligent modules (see below).

NOTE: If Unity Loader is connected to a CRA module, the MAC address of the CRA 
will be displayed in the MAC Address field.

Hardware ID

The hardware ID must match. If not, the transfer sign is marked red and crossed out. 
Transfer is disabled.

FW Version

The firmware (FW) version to be transferred should be later than the current one. If 
not, the transfer sign is marked yellow.

Element Description

PLC Device: name of the device
Version: version of the FW
Description: description of the FW
MAC Address: MAC address of the PLC
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Transfer Sign (Arrow)

Transfer sign (arrow between the PC´s and PLC´s property areas) indicates:

the transfer direction
significant comparison results between the PC´s and the PLC´s FW

Comparison Results

Comparison is only done for transfer from PC to PLC.

The comparison results are represented by colors:

Green indicates that the FWs of the PC and the PLC are compatible.
Yellow indicates that the FW of the PC is earlier than the FW of the PLC.
Red indicates that the FWs are not compatible. In this case the transfer sign is 
additionally crossed out.

FW Partial Transfer

If not all parts inside the selected firmware (FW) file (*.ldx) are compatible, the Unity 
Loader offers a partial download of the compatible FW parts.

A warning message is displayed that must be confirmed before partial download.

FW Transfer from PLC to PC

It is not possible to transfer the FW from PLC to PC.

In the Firmware tab the PC<=>PLC button is disabled.

Addressing Modules

The Module check box enables you to upgrade other modules (with firmware) of the 
Modicon M340 (e.g. BMX ART 0414).

Step Action

1 Activate the Module check box to display Rack.Slot of the device connected via 
Ethernet (e.g. 0.6).

2 Click the ... button ( ) right beside the Module check box to open the Module 
Address dialog where you can enter Rack Index and Slot Index of the module 
you want to upgrade.

3 Enter Rack Index and Slot Index and subsequently clicking OK.

4 Now you can upgrade the specified module.
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Constraints for Upgrading Modules

The following constraints apply to the upgrading modules feature:
This feature is not applicable to M340 Ethernet modules. M340 Ethernet modules 
can be upgraded by direct connection only (same as for CPUs).
After upgrading a module (with firmware), the FW version displayed in 
Unity Loader is not refreshed automatically.
To display the FW properties after upgrading you must perform a hardware reset 
of the PLC by pressing the reset button of the power supply or by power cycling 
the PLC.
After upgrading a module (with firmware) by using the Save on Memory Card 
feature, you must perform a hardware reset of the M340 PLC by pressing the 
reset button of the power supply or by power cycling the M340 PLC (else the 
module remains blocked in a non operational state).

Save on Memory Card

Please refer to Save on Memory Card, page 34.
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Save on Memory Card

Overview

NOTE: If Unity Loader is connected to a CRA module the checkbox 
Save on Memory Card is disabled and the text is changed to No Memory Card.

The Save on Memory Card feature provides the possibility to generate a memory 
card that can be used later for firmware (FW) upgrade of another M340 PLC.

As an upgrade by means of the memory card does not require the presence of Unity 
Loader, this option could be useful to upgrade M340 PLCs that can not be 
connected to the Unity Loader directly.

NOTE: The Save on Memory Card feature is only possible for M340 hardware 
platforms.

Save on Memory Card Unchecked

By default Save on Memory Card is unchecked.

The Unity Loader sends a request to upgrade the PLC immediately after the 
firmware (FW) is transferred to the memory card.

The FW files are stored only temporarily on the memory card and will be removed 
after upgrade is completed.

Save on Memory Card Checked

If Save on Memory Card is checked, the unzipped firmware (FW) files are 
transferred to the memory card of the PLC.

The files are marked for automatic upgrade.

At the end of the transfer you are asked to perform a manual reset of the PLC.

A reset will upgrade the FW of the PLC automatically, if the current version of the 
PLC is earlier than the version on the memory card and the FW on the memory card 
is compatible to FW on the PLC.

The files related to FW will be removed after upgrade.

NOTE: As it is not possible to display the data on the memory card, it is 
recommended to label the card after saving FW on the card.
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Source/Target PLC

You can use a memory card for firmware (FW) upgrade of another PLC.
Source PLC
On the source PLC you generate a memory card, remove it from the PLC and 
send it to the target PLC (e.g. to another site/country).
Target PLC
On the target PLC you insert the memory card and upgrade the FW.

NOTE: The memory card must remain on the target PLC.

Upgrading a PLC with Memory Card

To upgrade the target PLC using the memory card, created at the source PLC, 
proceed as follows:

Only 1 FW on Memory Card

Only 1 firmware (FW) can be saved on a memory card.

Each transfer, whether Save on Memory Card is checked or not, will erase the FW 
folder first.

Memory Card Write Protect

NOTE: If the memory card is write protected, it is not possible to perform an upgrade 
using the memory card.

Step Action

1 Check Save on Memory Card and start the transfer.
Result: 

The unzipped firmware (FW) files are transferred to the memory card of the 
PLC.
The files are marked for automatic upgrade.

2 Remove the memory card from the source PLC.

3 Insert the memory card to the target PLC.

4 Perform a manual reset at the target PLC.
Result:

The firmware (FW) of the target PLC is upgraded automatically, if the current 
version of the PLC is earlier than the version on the memory card and the FW 
on the memory card is compatible to FW on the PLC.

Note: 
The files on the memory card related to FW are removed after upgrade.
Note: 
The memory card must remain on the target PLC.
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Addressing Modules

For addressing modules (with firmware) please refer to Addressing Modules 
(see page 32).

Project on Memory Card

If there is a memory card present at a Modicon M340 and you transfer data using 
the Project tab of the Unity Loader, the following data are stored on the memory 
card for backup reasons:

Project (Unity Pro application)
Project Files

Data Storage files
User Web Files 

NOTE: Other user files (like Word, Excel, Adobe) and Project Data (%M, %MW, 
values of unlocated data) are not stored on the memory card.

Project and FW at Once

If you transferred data to a memory card (on the Project tab) as described above 
and you are using the Save on Memory Card feature on the Firmware tab, both 
data are present at the memory card.

NOTE: It is also possible to upgrade a project only without upgrading the firmware 
(FW).

Inserting the memory card into another PLC and performing a manual reset, the 
project and the FW are updated.

The memory card must remain on the target PLC.

NOTE: Take care to have the appropriate project on the memory card.
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One Shot/Multi Shot

For using the memory card there are 2 modes:
One shot
With the one shot mode, you need 1 memory card for 1 upgrade.
Multi shot
With the multi shot mode, you can use a memory card, generated on a source 
PLC, to update several target PLCs (for Unity Pro applications only).

For the possible use cases of the memory card please refer to the table below.

Area Description One Shot Multi Shot

System Area
(Firmware 
tab)

1 firmware (FW) 
(including Web pages if 
available)

Need 1 memory card per 
FW and per machine.

not supported
(The system 
removes the upgrade 
information after 
upgrade).

User´s Area
(Project tab)

Project (Unity Pro 
application)

No need to provoke a 
backup, the new memory 
card remains in the PLC.

You need to provoke 
a backup.

Data Storage files The new memory card 
remains in the PLC.

not supported

User Web Files 

other user files (like 
Word, Excel, Adobe) 

Project Data (%M, 
%MW, unlocated data)

not supported not supported
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Options Tab

Overview

The Options tab comprises a set of general settings for the Unity Loader.

Representation

Options tab
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Settings

Transfer Button

In the Options tab the Transfer button is disabled.

Element Description

Default backup 
directory:

backup directory for Unity Loader files (e.g. C:\Applications)
The default backup directory and the project name on the PLC are used to 
generate new project names (including path) automatically while 
transferring a project from PLC to PC (see page 26). .

FTP log file: name and path of the FTP log file
In this file, requests and replies exchanged between the loader´s FTP 
client and the PLC´s FTP server are logged.
Click the View button to look at the log file.
Click the Clear button to empty the log file.

Event log file: name and path of the event log file
In this file, the major events, such as FW transfer, PLC start / stop or 
unexpected events are logged.
Click the View button to look at the log file.
Click the Clear button to empty the log file.

Language: This list box displays the languages provided for the Unity Loader user 
interface.

English
French
German
Italian
Spanish
Chinese

To switch to another language click the arrow and select the respective 
language in the list.
Note: After switching to another language you have to close and launch 
again the Unity Loader.

TCP/IP / 
UNTLW / 
Modbus 
transmission 
timeout:

delay used for self-recovery while TCP/IP / UNTLW / Modbus transmission 
(seconds)
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About Tab

Overview

The About tab comprises information about your Unity Loader:

version
build
copyright information
license agreement
registration information

Representation

Unity Loader is a FreeTool which runs without registration.

Unity Loader checks the registration data according to the OneLicensing 
mechanism.

About tab
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License Agreement

Click the License agreement button to display the license agreement for your 
Unity Loader software.

Register Button

Click the Register now button to register your Unity Loader software.

Transfer Button

In the About tab the Transfer button is disabled.
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Scan Network Dialog Box

Overview

Clicking the Scan... button opens this dialog box.

Network scanning helps you to detect IP addresses of M340 PLCs in the network.

The Scan Network dialog box is modeless, i.e. the dialog box does not keep the 
input focus so scanning can be done in parallel.

Representation

Scan Network dialog box

IP Range

Specify the range of IP addresses, in which the hosts is searched after clicking the 

Start scan button. You can also click the auto-detect button ( ). to fill in the 
maximum range of the PC´s network segment.
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IP Address Properties

The IP Address properties comprise the following elements:

Command Buttons

The text of some buttons changes depending on the actual situation (e.g. Start Scan 
/ Cancel Scan). Grayed buttons are disabled.

The command button area comprises the following buttons:

If the Unity Loader is connected the Pick address button is disabled.

Element Description

IP Address IP address found in the network

Host Name host name of the found IP address

MAC Address MAC address of the found IP address

devices device assigned to the found IP address

Button Description

Start scan / 
Cancel scan

Click this button to start/cancel network scan.
The status of the scan process is displayed above the command buttons.

Pick address Click this button to fill the IP address of a selected host into the address box 
of the main dialog box. See Connection, page 19.

Close Click this button to close the Scan Network dialog box.
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Transferring Data Dialog Box

Overview

Clicking the Transfer button opens this dialog box.

The Transferring data dialog box displays a status report of the data transfer.

The dialog box is modal, i.e. you cannot return to the previous dialog box until the 
Transferring data dialog box is closed.

WARNING
RISK OF UNINTENDED EQUIPMENT OPERATION

Before transferring data to a PLC or to a module with firmware make sure that you 
have selected the correct project and firmware files and entered the correct target 
address. Verify the address by comparing the MAC address printed on the device 
with the MAC address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

WARNING
RISK OF UNEXPECTED EQUIPMENT BEHAVIOR

If the transfer of data failed (for example, if there was a power off of the PLC during 
the process), the PLC is in an undetermined state. In this case restart the transfer 
immediately to bring the PLC again in a defined state.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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Representation

Transferring data dialog box

Status Information

For application transfer the Transferring data dialog box comprises the following 
status information:

transfer started
number of bytes transferred
transfer completed

A status bar displays the transfer status.

For firmware (FW) transfer the Transferring data dialog box comprises the 
following status information:

transfer started
free space on memory card
required space
available space
directory information
transfer completed
writing files to flash memory
FW upgrade successful

A status bar displays the transfer status.

NOTE: The Transferring data dialog comprises only the main events. For detailed 
information please refer to the log files (Options Tab, page 38).
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Required Space

The amount of required space is a little bit larger than the data that should be 
transferred, because the firmware (FW) needs additional space for file 
management.

Available Space

The value of available space may be larger than the Free Space value displayed in 
the Memory Card status line because the calculation of available space takes into 
account the memory space of data that will be overwritten by new data.

Command Buttons

Grayed buttons are disabled.

NOTE: During firmware (FW) transfer the Abort and the Close buttons are disabled.

Button Description

Abort Click this button to abort the transfer.

Close Click this button to close the Transferring data dialog box.
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Example: Transfer of an 
Application from PC to PLC
Transfer of an Application from PC to PLC 

Procedure

The following table describes the procedure for transferring a Unity Pro application 
from a PC to a Modicon M340, Premium or Quantum PLC.

Step Action

1 Connect the PC and the PLC to the network.

2 If you do not know the required IP addresses click the Scan... button. (See Scan 
Network Dialog Box, page 42).

3 Enter the connection data: Media and Address. (See Connection, page 19).

4 Click the Connect button. (See Command Buttons, page 21).

5 Select the required project files (PC Project, PC Project Data, PC Project 
Files). (See PC Project Properties, page 24).

6 Set/reset the required Enable Transfer check boxes. (See Enable Transfer 
(Check Boxes), page 25).

7 If necessary set the transfer direction to PC->PLC by clicking the PC<=>PLC 
button. (See Command Buttons, page 21) and Transfer Signs (Arrows), 
page 26).

WARNING
RISK OF UNINTENDED EQUIPMENT OPERATION

Before stopping the PLC make sure that you are connected to the correct target 
address. Verify the address by comparing the MAC address printed on the device 
with the MAC address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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Step Action

8 Click the Stop PLC button. (See Command Buttons, page 21).

9 Click the Transfer button. (See Command Buttons, page 21).
Result: The Transferring data dialog box opens and displays a status report of 
the data transfer. (See Transferring Data Dialog Box, page 44).

10 After transfer is completed, close the Transferring data dialog box and click the 
Start PLC button
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Transfer of Applications in Batch 
Mode
Batch Mode with the Unity Loader Command Line Interface

Overview

The Unity Loader offers the command line interfaces UlUmas.exe for skilled users.

UlUmas.exe provides commands for transferring applications and data files via 
UMAS protocol.

The main usage is to transfer applications to one or several PLCs by calling a script 
without running Unity Loader dialogs but you can also start and stop PLCs.

Commands without Additional Checks

WARNING
RISK OF UNINTENDED EQUIPMENT OPERATION

Before executing commands by means of the command line interface make sure 
that the commands will not result in unintended situations for men or equipment.

The command line interface executes commands on the PLC without additional 
checks.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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Transfer FW or Transfer Project

Start PLC / Stop PLC

UMAS

UMAS stands for Unified Messaging Application Service, a platform independent 
protocol for exchanging application data.

Program

You can find the UlUmas.exe in the installation directory of your Unity Loader 
software.

WARNING
RISK OF UNINTENDED EQUIPMENT OPERATION

Before transferring data to a PLC make sure that you have selected the correct 
files and entered the correct target address. Verify the address by comparing the 
MAC address printed on the device with the MAC address shown by Unity Loader 
in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

WARNING
RISK OF UNINTENDED EQUIPMENT OPERATION

Before starting/stopping a PLC make sure that you are connected to the correct 
target address. Verify the address by comparing the MAC address printed on the 
device with the MAC address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

WARNING
UNKNOWN OPERATIONAL STATE OF EQUIPMENT

Evaluate operational state of equipment before starting or stopping a PLC. 
Unintended situations can occur if system state is not confirmed prior to starting or 
stopping a PLC.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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Documentation

You can find a detailed documentation (UlUmas.doc) in the installation directory of 
your Unity Loader software, too.

Running the Program

On your PC select Start → Run, enter UlUmas.exe in the Open dialog and confirm 
with OK.
33003805 07/2012 53



Transfer of Applications in Batch Mode

54 33003805 07/2012



Unity Loader

Index

33003805 07/2012
CBA
Index
A
addressing modules, 32

B
batch mode

UlUmas.exe, 51

C
command line interface

UlUmas.exe, 51
communication, 13
connecting, 19, 21

D
devices, 13
disconnecting, 21

F
firmware (FW), 29

version, 31

H
hardware ID, 31
33003805 07/2012
I
installation, 11
IP address 

properties, 43
range, 42

L
launching 

Unity Loader, 17
license agreement, 41

M
MAC address, 31
memory card, 19

save on, 34
module addressing, 32
module check box, 32

O
options, 38

P
PC projects, 22
PLC projects, 22
55



Index
R
registering, 41

S
save on memory card, 34
scanning

networks, 21, 42
settings, 38
starting

PLC, 16, 52
stopping

PLC, 16, 52

T
target devices, 13
transferring

application, example, 47
data, 44
FW, 21, 29
project, 21

U
UlUmas.exe, 51
56
 33003805 07/2012


	Unity Loader
	Table of Contents
	Safety Information
	About the Book
	Unity Loader General Information
	General
	Installation
	Preconditions

	Communication
	Target Devices

	Unity Loader Dialog Box
	General Description of the Dialog Box
	Project Tab
	Firmware Tab
	Save on Memory Card
	Options Tab
	About Tab
	Scan Network Dialog Box
	Transferring Data Dialog Box

	Example: Transfer of an Application from PC to PLC
	Transfer of an Application from PC to PLC

	Appendices
	Transfer of Applications in Batch Mode
	Batch Mode with the Unity Loader Command Line Interface


	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


